## Contents

Welcome!................................................................................................................................................... 4

Introduction ................................................................................................................................................ 4

Getting Started ......................................................................................................................................... 5

What do the LED colors mean? .................................................................................................................. 5

Start the KPN Mobile Internet Software ................................................................................................. 9

Get Online .................................................................................................................................................. 11

  LAN:......................................................................................................................................................... 11
  WLAN (WiFi): .......................................................................................................................................... 11
  Cellular Network (2G/3G): ...................................................................................................................... 12
  Which speeds can I expect over 2G/3G? ................................................................................................. 12
  Manage SIM Card PIN’s ......................................................................................................................... 13
  Locate New WLAN Networks .................................................................................................................. 13
  Access a Home/Office WLAN Network ................................................................................................. 13
  Check Your Network Usage .................................................................................................................... 13
  Set Network Usage Thresholds ................................................................................................................ 14
  Check Your Roaming Status .................................................................................................................... 14
  Send and Receive Text Messages .......................................................................................................... 14
  System Tray Icon ..................................................................................................................................... 14
  The KPN Mobile Internet Software ....................................................................................................... 14

The Menu Bar ........................................................................................................................................... 15

  The File Menu ......................................................................................................................................... 15
  The Networks Menu ............................................................................................................................... 16
  The Settings Menu .................................................................................................................................. 17
  The Help Menu ........................................................................................................................................ 18

The Feature Tabs ...................................................................................................................................... 19

  Connection Tab ....................................................................................................................................... 19
  The Usage Tab ....................................................................................................................................... 20
  Current Session ....................................................................................................................................... 21
  Connection History ................................................................................................................................. 22
  The Account Tab ..................................................................................................................................... 23
  Checking Your Prepaid Balance .............................................................................................................. 23
  Enter Prepaid Promotion Code .............................................................................................................. 24
  The Websites Tab .................................................................................................................................... 24

The File Menu ........................................................................................................................................... 25

The Networks Menu ................................................................................................................................... 25

  Network Selection .................................................................................................................................. 26
  Hotspot Locator ....................................................................................................................................... 27
  WLAN Scanner ........................................................................................................................................ 28
  Network Mode ......................................................................................................................................... 29

The Settings Menu ..................................................................................................................................... 29

  PIN Management ................................................................................................................................. 30
  Auto Connect ......................................................................................................................................... 30
  Enabling Prepaid ................................................................................................................................. 30
Welcome!

The underlying help topics explain the features and functionality of the KPN Mobile Internet Software.

Introduction

The KPN Mobile Internet Software is a tool that helps you manage your connections on the go. It is pre-configured with the information you need to connect to your operator’s cellular and wireless networks.

The KPN Mobile Internet Software lets you scan for WLAN and cellular networks, and incorporates a hotspot database that you can use to discover the addresses of WLAN hotspots in the vicinity.

It also helps you to be automatically connected to the best and fastest network at any place and time. For example a WLAN Access Point or WiFi hotspot can be faster and cheaper than a cellular network.

You can use The KPN Mobile Internet Software to monitor your network usage and you can if you wish set thresholds so that you will be warned if you exceed data on your subscription.

Using the KPN Mobile Internet Software you can configure connection and application preferences to meet your particular needs.

The KPN Mobile Internet Software contains an SMS/text messaging application that allows you to send and receive messages and to import, manage and export SIM contacts.

The KPN Mobile Internet Software assists you when roaming, warning you if you are connected to a different operator’s network and risking a roaming surcharge.

IMPORTANT NOTE: “Roaming” is the ability to use your Mobile Internet also in another country, i.e. other than your home-country. It depends on your subscription with your Mobile Network Operator whether this is possible or not.

IN GENERAL: It can occur that not all features and functionalities that are described in this manual are available. This can depend on the type of subscription or PrePaid that you have.
Getting Started

Upon first use of the KPN Mobile Internet Software, the KPN Mobile Internet Software will be auto configured according to your plan type (Subscription or Prepaid account). Your KPN Mobile Internet Software will then be configured with the necessary APN and profile information.

Here are just some of the things you can do with KPN Mobile Internet Software:

- Start KPN Mobile Internet Software
- Get Online
- Manage SIM Card PINs
- Locate New WLAN Networks
- Access a Home/Office WLAN Network
- Check Your Network Usage
- Set Network Usage Thresholds
- Check Your Roaming Status
- Send and Receive Text Messages

What do the LED colors mean?

Each device (Mobile Internet Card or Mobile Internet Modem, Dongle) is on the outside equipped with a multi-color LED that displays with certain colors to communicate what state the device is currently in.

These are the currently supported devices in this version of the KPN Mobile Internet Software.

You can find the type of modem that you are using on the packaging or on/in the modem-housing:

- KPN Mobiel Internet Kaart 810 (Option Globetrotter MAX HSUPA)
- KPN Mobiel Internet Kaart 820 (Huawei E870)
- KPN Mobiel Internet Modem 802 (Huawei E270)
- KPN Mobiel Internet Modem 804 (Huawei E180)
- KPN Mobiel Internet Modem 904 (Option GT iCON 505M)
- KPN Mobiel Internet Modem 905 (Huawei E367)
- KPN USB-Modem (ZTE MF628)
- KPN USB-Modem 2 (Huawei E1780)
- KPN USB-Modem 3 (ZTE MF190)
- KPN USB-Modem 4 (Huawei E3131)
- Hi USB-Modem (ZTE MF628)
- Hi USB-Modem 2 (Huawei E1780)
- Hi USB-Modem 3 (ZTE MF190)
• Hi USB-Modem 4 (Huawei E3131)
• Telfort USB-Modem 2 (Huawei E1780)
• Telfort USB-Modem 4 (Huawei E3131)
• Huawei E160 Huawei E1750

KPN Mobiel Internet Kaart 810
The LED on the ‘KPN Mobiel Internet Kaart 810’ has three different colors to show the different network types. Each color of the LED equals a certain network type.
• Red LED: Connection with a GPRS (2G) network
• Blue LED: Connection with a UMTS / HSPA (3G) network
• Red LED: Connection with a EDGE network.

KPN Mobiel Internet Kaart 820
The LED on the ‘KPN Mobiel Internet Kaart 820’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Green LED: Connection with a GPRS (2G) network
• Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network

KPN Mobiel Internet Modem 802
The LED on the ‘KPN Mobiel Internet Modem 802’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Green LED: Connection with a GPRS (2G) network
• Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network

KPN Mobiel Internet Modem 804
The LED on the ‘KPN Mobiel Internet Modem 804’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Green LED: Connection with a GPRS (2G) network
• Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

KPN Mobiel Internet Modem 904
The LED on the ‘KPN Mobiel Internet Modem 904’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Red LED: Powering up, unregistered/scanning or PIN required
• Red/blue blinking LED: Firmware crash
• Green blinking LED: Registering to GPRS or EDGE (2G) network
• Green continuous LED: Active connection via GPRS or EDGE (2G) network.
• Blue blinking LED: Registering to UMTS / HSPA (3G) network.
• Blue continuous LED: Active connection via UMTS / HSPA (3G) network.
KPN Mobiel Internet Modem 905

The LED on the ‘KPN Mobiel Internet Modem 905’ has two different colors to show the different network types. Each color of the LED equals a certain network type.

- Green LED: Connection with a GPRS (2G) network
- Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

KPN USB-Modem

In the ‘KPN USB-Modem’ there is a multi-color-LED (light), which shows the status of the modem, using different colors and flash-signaling:

- Red LED: Error Status, or Modem not ready yet, busy starting up.
- Green blinking LED: Attached to GPRS or EDGE (2G) network.
- Green burning LED: Active connection via GPRS or EDGE (2G) network.
- Purple blinking LED: Attached to UMTS / HSPA (3G) network.
- Purple burning LED: Active connection via UMTS / HSPA (3G) network.
- Blue burning LED: Active connection via HSDPA network.
- Light-blue burning LED: Micro-SD memory-card found and ready to use.

KPN USB-Modem 2

The LED on the ‘KPN USB-Modem 2’ has two different colors to show the different network types. Each color of the LED equals a certain network type.

- Green LED: Connection with a GPRS (2G) network
- Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

KPN USB-Modem 3

The LED on the ‘KPN USB-Modem 3’ has two different colors to show the different network types. Each color of the LED equals a certain network type.

- Green LED: Connection with a GPRS (2G) network
- Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

KPN USB-Modem 4

The LED on the ‘KPN USB-Modem 4’ has two different colors to show the different network types. Each color of the LED equals a certain network type.

- Green LED: Connection with a GPRS (2G) network
- Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

Hi USB-Modem

In the ‘Hi USB-Modem’ there is a multi-color-LED (light), which shows the status of the modem, using different colors and flash-signaling:

- Red LED: Error Status, or Modem not ready yet, busy starting up.
- Green blinking LED: Attached to GPRS or EDGE (2G) network.
- Green burning LED: Active connection via GPRS or EDGE (2G) network.
- Purple blinking LED: Attached to UMTS / HSPA (3G) network.
• Purple burning LED: Active connection via UMTS / HSPA (3G) network.
• Blue burning LED: Active connection via HSDPA network.
• Light-blue burning LED: Micro-SD memory-card found and ready to use.

**Hi USB-Modem 2**
The LED on the ‘Hi USB-Modem 2’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Green LED: Connection with a GPRS (2G) network
• Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

**Hi USB-Modem 3**
The LED on the ‘Hi USB-Modem 3’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Green LED: Connection with a GPRS (2G) network
• Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

**Hi USB-Modem 4**
The LED on the ‘Hi USB-Modem 4’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Green LED: Connection with a GPRS (2G) network
• Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

**Telfort USB-Modem 2**
The LED on the ‘Telfort USB-Modem 2’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Green LED: Connection with a GPRS (2G) network
• Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

**Telfort USB-Modem 4**
The LED on the ‘Telfort USB-modem 4’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Green LED: Connection with a GPRS (2G) network
• Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.

**Huawei E160**
The LED on the ‘Huawei E160’ has two different colors to show the different network types. Each color of the LED equals a certain network type.
• Green LED: Connection with a GPRS (2G) network
• Blue/Cyan LED: Connection with a UMTS / HSPA (3G) network.
**Huawei E1750**

The LED on the 'Huawei E1750' has two different colors to show the different network types. Each color of the LED equals a certain network type.

- **Green LED**: Connection with a GPRS (2G) network
- **Blue/Cyan LED**: Connection with a UMTS / HSPA (3G) network.
Start the KPN Mobile Internet Software

To start KPN Mobile Internet Software, either click on the KPN Mobile Internet Software desktop icon or select Programs > KPN > KPN Mobile Internet Software from the Windows Start menu.

Also, as soon as you plug the (USB-)Modem into your laptop or Desktop-PC, the program will start automatically (provided that “AutoStart” on your PC is enabled).

The screens below are based on Windows 7. On another Operating System it can look slightly different.

Choose the option “Run Setup.exe” here.

The program will now start, and ask for the PIN-code of your SIM-card.

For a new (U)SIM-card, the default PIN is 0000.
Get Online

**LAN:**
If you are using a LAN connection, your internet connection is already on and you can get online immediately. Note in the screenshot below that the LAN icon is highlighted green, which means that you are connected via (wired) LAN.

![LAN Connection Screenshot]

**WLAN (WiFi):**
To start a WLAN connection, click on the WLAN button. You may need to select your network from the Find WLAN Networks window and click Connect. If the network is encrypted, you must first enter a Security Key to connect. KPN Mobile Internet Software will store the security key for future connections to this network. Note in the screenshot below that the WLAN icon is highlighted green, which means that you are connected via Wireless LAN (= WiFi).

![WLAN Connection Screenshot]
Cellular Network (2G/3G):
To start a 2G/3G Mobile Internet connection, all you need to do is click on the “Connect” button or one of the application launch buttons on the Websites Tab.
Note in the screenshot below that the Cellular icon is highlighted green, which means that you are connected via a Cellular Network.

NOTE: The KPN Mobile Internet software will automatically switch to the best (fastest/cheapest) connection technology (LAN/WLAN/2G/3G), while you are working. That will reduce the amount of data (MegaBytes) over 2G/3G Mobile Networks, so your mobile bill will be lower. It can however happen that a data-download process that was already running, continues downloading over 2G/3G, while the Software has already switched over to for example WLAN. This can be for example a radio-listening session or a file download. To be absolutely sure that all “new” data goes in that case over WLAN, you have to close down these running (download-)sessions and start them again.

Which speeds can I expect over 2G/3G?
Your Mobile Internet product (Card or USB-Dongle) can register to various Mobile Networks with various Technologies and according Download- and Upload-speeds.
This is displayed with a clear indicator in the main-screen of the Mobile Internet Software. See the screenshots below here.

The speeds are depending on the type of Mobile Internet product (Card or USB-Dongle) that you are using. See the packaging of the product on which the specifications are printed.

Next to that, the speed that you are experiencing is very much depending on the network with which you have a connection, the distance to the mobile transmitter, and the intensity of traffic (number of users) at that moment and at the place where you are working mobile.
At this moment, generally there are 2 types of Mobile Networks. Because of continuous technical developments, this number will expand and the speeds will increase all the time.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>2G, GSM, GPRS, EDGE</th>
<th>3G, UMTS, HSDPA, HSUPA, HSPA</th>
</tr>
</thead>
</table>
| Short explanation | 2nd Generation Mobile Network  
Older (slower) networks.  
Download-speeds up until maximum 56Kbps (GPRS) or 250 Kbps (EDGE).  
| | 3rd Generation Mobile Network  
Newer (faster) networks.  
Download-speeds up until (at this moment) maximum 14,4 Mbps.  |

**Manage SIM Card PIN’s**
Select Settings, PIN Management to enter or change the SIM card PIN or disable PIN usage. See PIN Management for further details.

**Locate New WLAN Networks**
Click on the WLAN button on the main-screen to display details of all the WLAN networks (including public hotspots) available in your current location, or select Networks, WLAN Scanner to open the Find WLAN Networks dialog. See Find WLAN Networks for further details.

**Access a Home/Office WLAN Network**
To set up access to a WLAN network in your home or office:
1. Go to your home/office.
2. Ensure the WLAN device is enabled or turned on. The image on the KPN Mobile Internet Software WLAN button will be highlighted if a WLAN connection is possible at that time.
3. Click on the WLAN button or select Networks, WLAN Scanner to display a list of all accessible WLAN networks in the Find WLAN Networks dialog. Note that the list may contain several networks if you have close neighbors with WLAN networks.
4. Select your desired network from the Find WLAN Networks list, and click on Connect.... If the network is encrypted, you must first enter a Security Key to connect. KPN Mobile Internet Software will store the security key for future connections to this network. (If your network is a “hidden network” that does not broadcast its SSID, then it will not appear in the Find WLAN Networks list.)

**Check Your Network Usage**
You can click on the Usage history tab in the software to check up on your network usage. See The Usage Tab for further details.
Set Network Usage Thresholds
Select Settings, Advanced Settings..., Thresholds and set the desired threshold in MB, as well as the frequency in which you wish to receive warning notifications you are nearing that threshold. (For calculation: 1MB = around 1000 kB).

Select Settings, Advanced Settings..., Preferences and select the Roaming tab to set thresholds that you can use to limit your network usage when roaming.
When you reach a threshold you have set, a warning message is displayed.

Check Your Roaming Status
You can check your roaming status at any time by looking for the roaming indicator in the KPN Mobile Internet Software.

Send and Receive Text Messages
You can send and receive text messages and manage SIM card contacts from your PC using KPN Mobile Internet Software’s built in SMS application, which you can start by clicking on the Envelope icon in the KPN Mobile Internet Software. See SMS/Text Messaging for further details.

System Tray Icon
An KPN Mobile Internet Software icon is displayed in the system tray if the KPN Mobile Internet Software has been hidden (minimized). To display the software, double click on the icon. To terminate KPN Mobile Internet Software, right-click on the icon and select Exit from the menu.

The KPN Mobile Internet Software
The KPN Mobile Internet Software contains a standard Windows Menu Bar at the top, and Feature Tabs below. The two buttons in the top right corner of the software can be used to minimize the software to a system tray icon, and to terminate the software.
The Menu Bar

The KPN Mobile Internet Software Menu Bar contains the following menus:

The File Menu

This menu contains the following options:

• Exit
  Terminates KPN Mobile Internet Software.
The Networks Menu

This menu contains the following options:

- **Network Selection**
  Lets you switch between automatic network selection (the default) and manual network selection.

- **Hotspot Locator**
  Lists all the WLAN hotspots you have access to around the world.

- **WLAN Scanner**
  Lists all the WLAN networks located in your vicinity.

- **Network Mode**
  Lets you limit the types of cellular network that KPN Mobile Internet Software will connect to.
The Settings Menu
This menu contains the following options:

- **PIN Management**
  Lets you enable and disable the PIN code security checks on SIM cards.

- **Auto Connect**
  Allows the client to automatically connect when launched.

- **Enable Prepaid**
  If you select Enable Prepaid you can check your balance and top-up your prepaid account using the **Account** tab.

- **Advanced Settings**
  Provides access to a range of advanced functions such as Profiles, Preferences and other configuration settings.
The Help Menu
This menu contains the following options:

- **Help**
  Displays help about KPN Mobile Internet Software.

- **User Guide**
  Opens the complete User Guide document.

- **Getting Started**
  Opens the complete Getting Started document.

- **Diagnostics...**
  Displays information about your configuration to help diagnose KPN Mobile Internet Software.

- **About...**
  Displays version information about KPN Mobile Internet Software.
The Feature Tabs

The Feature Tabs on the KPN Mobile Internet Software are as follows:

- Connection
- Usage
- Account
- Websites

Connection Tab

The Connection Tab displays the following:

- **Connection Type** indicators that highlight the connection method currently in use (LAN, WLAN, 3G/HSPA) and others that are available for connection. If a Connection Type is not available for use, it is not highlighted, nor can you select it. The current WLAN and 3G signal strength is also indicated here.
- A 3G/HSPA status message that either describes any 3G action currently being performed by KPN Mobile Internet Software and the network name.
- A Personal Usage Meter to show how close you are to your usage threshold.
- A RED roaming indicator. This is only lit when you are connected to a roaming network (so other than your home network).
• An envelope that will take you to the SMS application.
• A new SMS/text message indicator that indicates when a new text message has been received.

Some devices (all handsets and some PC cards) supported by the KPN Mobile Internet Software do not report signal strength while a connection is active. In this case, the signal level reported by KPN Mobile Internet Software is only reliable when no connection is active.

Refer to the Getting Started section for more information on using KPN Mobile Internet Software.

The Usage Tab
The Usage Tab contains the following options:
• Current Session
  Select this option to display network usage information for the current session. The information is displayed in the KPN Mobile Internet Software’s status panel, replacing the usual status display. For details, see Current Session.
• History
  Select this option to display historical network usage information. The information is displayed in the KPN Mobile Internet Software’s status panel, replacing the usual status display. For details, see History.
• Usage Meter Settings
  Select this button to display the Usage Meter Settings, where you can set usage limits and configure warning notifications when you are near those limits. For details, see Personal Usage Meter.
**Current Session**

The **Current Session** pane contains information about the download speeds achieved during the current session, the duration of the current session, plus the following statistics for both upload and download traffic:

- Speed
- Volume
- Average speed
- Connection duration

<table>
<thead>
<tr>
<th></th>
<th>Upload</th>
<th>Download</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed</td>
<td>107 kbps</td>
<td>7505 kbps</td>
<td></td>
</tr>
<tr>
<td>Average</td>
<td>71 kbps</td>
<td>4493 kbps</td>
<td></td>
</tr>
<tr>
<td>Volume</td>
<td>306 KB</td>
<td>18.7 MB</td>
<td>19 MB</td>
</tr>
<tr>
<td>Duration</td>
<td>00:00:34</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: The data usage in the data-counter can possibly differ from the data usage on your bill. Also when multiple computers are used, the data usage is counted in each computer separately and not added up in total.
**Connection History**

The *Connection History* pane contains statistics regarding all traffic sent and received via KPN Mobile Internet Software during a selected period. It contains a bar graph showing the total traffic (upload and download) for each day during the selected period, for a selected bearer or all bearers.

You can filter the time period and traffic type from the pull-down menus in the upper right-hand corner.

The time period options are:

- Today
- This week
- Last 7 days
- Current month
- Last 30 days
- Previous month

The traffic type options are:

- National traffic - use on your provider’s network
- Roaming traffic - any use outside of your provider’s network that could incur roaming charges
- Total traffic - all usage on all network types
The Account Tab

The Account Tab lets you access your Mobile Internet account.

Clicking Login opens your default Internet Browser and allows you to login and access basic account maintenance tools and services.

If you are a Prepaid customer, and have selected the Enable Prepaid option from the Settings menu, you may also access the following account services directly:

- Check your Balance
- Enter Prepaid Promotion Code

Checking Your Prepaid Balance

If you are a Prepaid customer, you can use the Account Tab to check the balance on your prepaid account. If you have enabled prepaid from the KPN Mobile Internet Software Settings menu, you can access this information.

To do so, select the Account Tab and click on the Check Balance button. You will then see a notification in that area with your account balance.

You may access the Check Balance button only when a SIM is correctly inserted, the PIN-code is entered, and you are connected to a home network (see signal strength bars).

This option is unavailable when you are roaming, so when you are connected to a foreign network.

Note: Your modem or configuration may not support this feature.
Enter Prepaid Promotion Code

If you are a Prepaid customer, you can use the Account Tab to enter Promotion Codes to perform various account actions and access KPN account services. Enter the code in the space provided and click Send. You will then see a response to your request in that area.

This feature can also include topping-up your Prepaid balance. Ask your Mobile Network Operator or Service Provider which services are supported.

The Websites Tab

The Websites Tab has been configured to launch some of your frequently used websites and services, such as Google or your e-mail or VPN clients.
The File Menu

From the File menu you can select Exit to close KPN Mobile Internet Software.

The Networks Menu

This menu contains the following options:

- **Network Selection**
  Lets you switch between automatic network selection (the default) and manual network selection.
- **Hotspot Locator**
  Lists all the WLAN hotspots you have access to around the world.
- **WLAN Scanner**
  Lists all the WLAN networks located in your vicinity.
- **Network Mode**
  Lets you limit the types of cellular network that KPN Mobile Internet Software will connect to.
Clicking on **Networks, Network Selection** displays the **Network Selection** dialog where you can switch between automatic and manual network selection. You may sometimes wish to switch to a network other than the one selected by Mobile Internet, for reasons of cost or quality.

To switch to manual mode and select the network yourself:

1. Select **Manual**.
2. Click on **Select operator** to display the **Change Network Operator** dialog.
3. Select the required network and click **Change Operator**.
4. Click **OK**.

To switch back to automatic mode:

1. Select **Automatic**.
2. Click **OK**.
The Hotspot Locator displays hotspot location information supplied by your mobile operator. “Hotspots” are the public access WLAN networks available in many hotels, airports, stations, cafés and so on.

You can access the Hotspot locator by either selecting Networks, Hotspot Locator or by selecting Settings, Advanced Settings, Hotspot Locator.

To use the hotspot locator to find out what hotspots are available in a particular location, select the Country, Region and City you are interested in and then click Search. If you wish, you can narrow the search by selecting a Category as well before you click Search.

The hotspots that match your search criteria are listed in the Result Area. Selecting one of the items in this list displays further information about the hotspot (address, phone number, web address and so on).

Click Reset to delete your search results and start a new search.
Select **Networks, WLAN Scanner** to display the **Find WLAN Networks** window. Here, you can view all WLAN networks detected in the vicinity.

The following information is displayed for each detected network:

- **SSID** - This is the name of the wireless network, usually broadcast by the wireless access point.
- **Signal** - This icon indicates the current signal strength of the network.
- **Encrypted** - This icon, if displayed, indicates that the network is encrypted and requires you to provide authentication information before you can connect.

If you move the PC or believe that a new network has become available, you can force a new scan by clicking the **Refresh** button.

To start using one of the detected networks:

1. Select the network and then click **Connect**.
2. If the network is not encrypted and does not require a password to connect, you will be connected without providing any authentication information.
3. If the network is encrypted, you must first enter a **Security Key** to connect. KPN Mobile Internet Software will store the security key for future connections to this network. (If your network is a “hidden network” that does not broadcast its SSID, then it will not appear in the **Find WLAN Networks** list.)
Network Mode

Select Network Mode from the Networks menu to switch between 3G Preferred, 3G Only, or 2G Only network selection. You may sometimes wish to switch to a network other than the one selected by KPN Mobile Internet Software for reasons of cost or quality.

To select the network type:
1. Click on Networks, Network Mode.
2. Select 3G Only or 3G Preferred or 2G Only.

The Settings Menu

This menu contains the following options:

- **PIN Management**
  Displays the Manage PINs dialog, which you can use to enable and disable the PIN code security checks on SIM cards.

- **Auto Connect**
  If you select Auto Connect a connection will be made automatically when the application is launched.

- **Enable Prepaid**
  If you select Enable Prepaid you can check your balance using the Account tab.

- **Advanced Settings**
  Displays the Advanced Settings dialog, which provides access to a collection of advanced configuration dialogs. Some of these dialogs (the more commonly used ones) are also accessible from other menu options. Note that this menu option may be password protected: in this case a password prompt is displayed and the Advanced Settings dialog will not be displayed unless you enter the correct password.
PIN Management
Under normal circumstances, each time a cellular device with a SIM card is inserted, you will be prompted to enter the PIN code. Until you have entered the correct PIN code, you will not be able to use the device. The PIN Management option lets you disable and re-enable the PIN code on a PC card and, in the case of some devices, change the PIN code.

To modify the PIN code setting of a PC card:
1. Select Settings, PIN Management.
2. To disable the PIN code, check No PIN, to enable it, check Use PIN.
3. If the fields Current PIN, New PIN and Confirm PIN are displayed then you can change the PIN code by entering the old PIN code in the Current PIN field and the new PIN code in both the New PIN and Confirm PIN fields.

If you enter a PIN code incorrectly, you will receive a warning with the number of attempts remaining before the SIM card is locked. In most cases, entering an incorrect PIN 3 times in succession, the SIM card is locked and you will be required to enter a PUK code to unlock it. Contact your operator help desk for information on your PUK code.

Auto Connect
Select Auto-Connect from the Settings menu to allow KPN Mobile Internet Software to initiate a connection each time the application is launched. Simply de-select the Auto-Connect menu option if you wish to manually initiate connections.

Enabling Prepaid
If you are a Subscription customer, the Prepaid options will be disabled by default.

If you are a Prepaid customer, the Prepaid option will be enabled by default.

If, for any reason, you change your account status, you can also manually edit this setting. To enable and access the Prepaid account management tools, select Enable Prepaid from the Settings menu. You can then check your balance and top-up your prepaid account using the Account tab. Simply de-select the Enable Prepaid menu option if you are a Subscription customer and wish to disable this feature.
Advanced Settings

Some of the Advanced Settings allow you to make changes that can affect the operation of the client, so you should be careful when using them, and only make changes in consultation with your system administrator or product support specialist. For the same reason, you may need to enter a password in order to access the Advanced Settings. If this is the case, ask your system administrator or product support for the password.

The Advanced Settings dialog allows you to edit the following options:

- **Connections**
  Displays the Connections dialog, which you can use to add, modify and delete connections.

- **Default Devices**
  Displays the Set Default Devices dialog, which you can use to change KPN Mobile Internet Software's default devices. This dialog can also be accessed from the KPN Mobile Internet Software’s Settings menu.

- **Device Installer**
  Displays the Device Installer wizard, which guides you through the device selection and installation procedure.

- **Diagnostics**
  Displays the Diagnostics dialog, which provides access to a range of diagnostic information.

- **Export Profiles**
  Displays the Export Setup dialog, which allows you to export and save your Websites Tab launch buttons for use with other installations of KPN Mobile Internet Software.

- **Hotspot Locator**
  Displays the Hotspot Locator dialog, which lists all the WLAN hotspots to which you have access. This dialog can also be started from the KPN Mobile Internet Software’s Networks menu.

- **Import Profiles**
  Displays the Import Setup dialog, which allows you to import saved Websites Tab launch buttons for use with other installations of KPN Mobile Internet Software.

- **Preferences**
  Displays the Preferences dialog, which allows you to set various general application preferences.

- **Restore Configuration**
  Displays the Restore Configuration dialog, which lets you save and restore the KPN Mobile Internet Software configuration to an earlier state.

- **Set Password**
  Displays the Set Password dialog, which lets you set password protection on the Advanced Settings dialog.

- **Personal Usage Meter**
  Displays the Usage Meter Settings dialog, which lets you set usage limits and enable warning notifications when you near those limits.
Connections

The Connections dialog lists all of your existing connections.
To add a new connection:

1. Click on **Settings, Advanced Settings** and **Connections** to open the **Connections** dialog.

2. Click on **Add...** to add a new connection.

3. Enter a Connection name in the space provided [Example_APN]
4. On the **General** tab select a bearer from the list of available connection types (Dial-up, 2G/3G/HSPA). Refer to Connection Properties for more details on configuring each individual connection type. Then press **OK**.

Also click this **OK**

5. In the Tab “2G/3G/HSPA”, enter the appropriate APN in the designated field [example].
6. In the Tab “Security” you can enter the Username and Password for this APN, if applicable.
7. Now click on the button “Add to profile...”. 

8. Select the new profile [Example_APN] and click the “<” button to add this profile to the list of “Selected Connections” on the left.
9 Now, at the left, again select this new profile [Example_APN] and click multiple times on the “Up” button to move it to the highest priority.

10 Then this is the result, and finally click on “OK”.

![Profile Properties window](image)

![Profile Properties window](image)
11 Now, in the Connections-screen, you will see this profile on top. Click on “OK” now to confirm and close this screen.

12 On the **Websites** tab, you can add or modify any launch applications to be associated with that particular connection. Refer to The Websites Tab section for more information on setting and configuring Launch Applications.

13 Once the connection has been configured, click **OK**.

To modify an existing connection:

1. Click on **Settings**, **Advanced Settings** and **Connections** to open the **Connections** dialog.
2. Select a connection from the list and click on **Properties**.
3. Modify any configuration information on the General and Websites tabs. Note that some of your system’s default connection configurations cannot be modified.
4. Click **OK**.

To delete an existing connection, select a connection from the list and click on **Delete**. A dialog will appear asking you to confirm the deletion and proceed.

To import a connection definition from a Windows RAS connection, click on **Import**....

To add a connection to the active profile (for more information on profiles, see Profiles), click on **Add to profile**.... Select a connection from the Available Connections pane, then click on the arrow button to move it to the Selected Connections pane. The Selected Connections can be moved using the Up and Down buttons; the top connection in the list is the preferred connection. If the preferred connection is unsuccessful, the next connection in the list is tried, and so on. On the **Websites** tab, you can add or modify any launch applications to be associated with that
particular connection. Refer to The Websites Tab section for more information on setting and configuring Launch Applications. When finished, click OK.

**Connection Properties**

When you select a connection for editing or add a new connection, the Connection Properties or Add Connection dialog is displayed and contains two tabs:

- **Applications** - lets you associate applications with the connection, so they are automatically launched when the connection is established. For further information about these settings, see The Websites Tab.
- **General** - allows you to define the connection bearer type (2G/3G/HSPA or Dialup). LAN and WLAN connections are managed by your operating system and cannot be configured or saved in KPN Mobile Internet Software.

Selecting the Properties... button on the General tab displays a dialog specific to the selected connection bearer type on the General tab. Therefore, if 2G/3G/HSPA has been selected from the Bearer list, a dialog will open containing 2G/3G/HSPA Bearer Settings.

These different bearer types and associated connection properties are described in the following sections:

- Dial-up Connection Properties
- 2G/3G/HSPA Connection Properties
- 2G/3G/HSPA Tab
- General Tab
- Internet Protocol Tab
- Proxy Tab
- PPP Tab
- Security Tab

**Dial-up Connection Properties**

If you wish to define the connection properties for a Dial-up connection, proceed as follows:

1. Click on **Settings**, **Advanced Settings** and **Connections** to open the **Connections** dialog.
2. Select the **Dial-up** bearer you wish to edit and click **Properties**.
3. Edit necessary settings on the following tabs:
   - Dial-up - Enter the Phone number to call in the space provided. Check the Remove RAS connection on disconnect option if you want the RAS connection created during connection establishment to be removed on disconnection.
   - General
   - Internet Protocol
   - Proxy
   - ppp
   - Security
4. Click **OK**.
2G/3G/HSPA Connection Properties

If you wish to define the connection properties for a 2G/3G/HSPA connection, proceed as follows:

1. Click on Settings, Advanced Settings and Connections to open the Connections dialog.
2. Select the 2G/3G/HSPA bearer you wish to edit and click Properties.
3. Edit necessary settings on the following tabs:
   - 2G/3G/HSPA
   - General
   - Internet Protocol
   - Proxy
   - PPP
   - Security
4. Click OK.

Proxy Tab

If you are editing Dial-up or 2G/3G/HSPA connection properties, you may edit the following settings via the Proxy tab:

- Override local Proxy settings - check this option if you want to override local Proxy settings and specify a Proxy server here. The Proxy server parameter group is then enabled.
- Automatically detect settings - check this option if you want Proxy server settings to be automatically detected and configured on a per-connection basis.
- Use automatic configuration script - check this option if you want to use a PAC configuration script. You must then enter the URL of a server containing the script into the Address field. This option is useful in some corporate remote access scenarios.
- Use a Proxy server - check this option if you want to use a Proxy server for outgoing HTTP connections. You must then enter the IP address of the Proxy server and the port number to use in the Address and Port fields.
- Bypass Proxy server for local addresses - check this option if you do not want to use the Proxy server for internal HTTP traffic.
- Advanced... - click on this button to display the Proxy Settings dialog, which you can use to specify your use of Proxy servers in more detail.

Advanced Proxy Settings

If you are editing Dial-up or 2G/3G/HSPA connection properties, and you opt to Override local Proxy settings, you may edit the following by clicking on the Advanced button in the Proxy tab:

- HTTP - These fields contain a copy of the address and port number entered into the Address and Port fields in the Proxy tab on the main bearer settings dialog. If you change the settings here, they will also be changed on the Proxy tab. By default this Proxy address and port number will be used for all requests. If, however, you uncheck Use same Proxy for all protocols, then they will only be used for ordinary HTTP requests.
- Secure - If you uncheck Use same Proxy for all protocols, then you will need to enter a Proxy address and port number in these fields for use with secure HTTPS requests.
- Use same Proxy for all protocols - Uncheck this option if you want to use different Proxy servers for HTTP and HTTPS requests.
• **Do not use Proxy server for addresses beginning with** - Enter the names of any domains for which you do not requests to be routed via a Proxy. The domain names must be separated by semicolons (for example: `www.mycompany.com;www.yourcompany.co.uk`).

**Security Tab**

The Security tab has settings for your 2G/3G or Dialup security:

- **Enable firewall** - This option is only available on Windows XP. Check it to enable the Windows XP firewall on the connection.
- **Authentication** - Select the required authentication protocol (if any) from one of the displayed options: PAP, SPAP, CHAP, MS-CHAP

Your network manager or provider should tell you which of these options to select. If you select an authentication protocol, then you will need to:

  - Either enter your login credentials into the **Username**, **Password** and **Confirm Password** fields. Your credentials are stored in encrypted form.
  - Or check the **Prompt for username and password** option. You will then be required to enter your Username and password at connection time.

**2G/3G/HSPA Tab**

You may edit the following 2G/3G/HSPA settings on the 2G/3G/HSPA tab:

- **Access point name** - Enter the name of the access point to be used for GPRS connections.
- **PDP type** - Select either IP or PPP. Most terminals and networks only support IP.
- **Use data compression** - Check this option to enable data compression.
- **Use header compression** - Check this option to enable IP header compression.
- **Remove RAS connection on disconnect** - Check this option if you want the RAS connection created during connection establishment to be removed on disconnection.

**General Tab**

You may edit the following Dial-up/2G/3G/HSPA settings on the **General** tab:

- **Show modem lights** - Check this option if you want a connection icon to be displayed in the windows system tray, indicating that a connection has been established and providing access to connection status information.

**Internet Protocol Tab**

You may edit the following Dial-up/2G/3G/HSPA settings on the Internet Protocol tab:

- **Obtain an IP address automatically** - Select this option if your network assigns IP addresses automatically from a DHCP or Radius server. This is usually the case, so if in doubt, choose this option.
- **Use the following IP address** - Select this option if your network manager has supplied you with a fixed IP address. Enter the **IP address**, **Subnet mask** and **Default gateway** address supplied by your network manager.

Most networks support assigning IP and DNS address details automatically via either a DHCP or Radius server. In that case, the default settings for automatic assignment are recommended. In some cases, however it may be required to assign IP and DNS address information manually.
• **Obtain DNS server address automatically** - Select this option if your network supplies a DNS server address automatically. This is usually the case, so if in doubt, choose this option.

• **Use the following DNS server address** - Select this option if your network manager has supplied you with fixed DNS server addresses. Enter the supplied addresses in the **Preferred DNS server** and **Alternate DNS server** fields.

• **Preferred WINS server** - Enter the IP address of the preferred WINS server that is to be used for resolving NetBIOS names.

• **Alternative WINS server** - Enter the IP address of an alternate WINS server that is to be used for resolving NetBIOS names, if the preferred WINS server is not available.

• **DNS Suffix** - Enter a DNS suffix that will be appended to any unqualified host names used on this connection. If, for example, the user tries to access a host called “xyz” and a DNS suffix of “mycompany.com” has been specified, the host actually searched for will be “xyz.company.com”. The suffix is only appended to unqualified host names (that is host names that do not already include a DNS suffix).

**PPP Tab**
You may set PPP parameters for Dial-up/2G/3G/HSPA settings on the PPP tab, should it be necessary to use non-default settings (to connect to a corporate network, for example). Please consult your network administrator or Windows Support Center if you need to configure these settings.

**Default Devices**
The Default Devices dialog lists KPN Mobile Internet Software’s default devices to be used when connecting to a particular bearer. KPN Mobile Internet Software automatically selects a default device for various bearers during device installation.

To set or change the default device for a bearer:

1. Click on **Settings, Advanced Settings** and **Default Devices** to open the **Default Devices** dialog.
2. Select the desired bearer type from the list of bearer types.
3. Click on **Change**....
4. Select the required device from the displayed list of available installed devices. Note that the list may include devices that are not currently connected to the PC.
5. Click **OK**.
Device Installer

The Device Installer wizard guides you through the device selection and installation process for that specific device.

1. Click on **Settings**, **Advanced Settings** and **Device Installer** to launch the **Device Installer** wizard.
2. Click **Next** to proceed.
3. Select the device to be installed from the list of supported devices.
4. Select the connection method, if necessary (Bluetooth, Infared, serial).
5. Click **Next** to proceed.
6. A dialog will display informing you of any additional actions required to completed the device installation, or to confirm that the device was successfully installed.
7. Click **Finish** to close the Device Installer wizard.

Diagnostics

The Diagnostics dialog provides a range of diagnostic information, including a log file, general information about the PC on which the software is installed, plus hardware and software information relevant to the operation of **KPN Mobile Internet Software**. It also provides shortcuts to various Windows Control Panel tools that can be useful when troubleshooting.

The dialog contains three tabs:

- **Diagnostics**
  This tab contains general information about the system hardware and software. Of particular interest is the **Defect Analysis** option, which displays information about any PC card defects detected by the connection manager. Under normal circumstances, selecting this option does not display any information in the right-hand pane; information is only displayed there if an error has been detected. Should you have a problem and find information displayed by the Defect Analysis option, click on **Save** to save the information to disk and contact support.

- **Log**
  This tab displays a log file describing recent connection manager activity.

- **Shortcuts**
  This tab contains shortcuts to various useful Windows Control Panel tools. Note that any changes you make using these tools will have a system wide effect, and should therefore only be made on the advice of your system administrator or support personnel. Local administrative rights on the PC may be required to make changes.

The **Save** button saves the diagnostics information to disk for reference during a support call.

Export Profiles

The Export Profiles or Export Setup dialog allows you to transfer and use your Websites Tab launch buttons if you install KPN Mobile Internet Software on another computer.
To export your Websites Tab items:
1. Select **Settings, Advanced Settings, Export Profiles**.
2. Select the type of export you wish to perform:
   3. **Export whole setup** - Choose this option if you want to export all of the application launch buttons from your current KPN Mobile Internet Software configuration.
   4. **Export only selected tasks** - Choose this option if you want to export specific items such as an e-mail or VPN configuration.
3. Click **OK**.
4. Specify the file name and location to save the configuration.

Refer to the Import Profiles section to learn more.

**Hotspot Locator**

The Hotspot Locator displays hotspot location information supplied by your mobile operator. “Hotspots” are the public access WLAN networks available in many hotels, airports, stations, cafés and so on.

You can access the Hotspot locator by either selecting **Networks, Hotspot Locator** or by selecting **Settings, Advanced Settings, Hotspot Locator**.

To use the hotspot locator to find out what hotspots are available in a particular location, select the **Country, Region** and **City** you are interested in and then click **Search**. If you wish, you can narrow the search by selecting a **Category** as well before you click **Search**.

The hotspots that match your search criteria are listed in the **Result Area**. Selecting one of the items in this list displays further information about the hotspot (address, phone number, web address and so on).

Click **Reset** to delete your search results and start a new search.

**Import Profiles**

The Import Profiles or Import Setup dialog allows you to import a previously exported and saved KPN Mobile Internet Software Websites Tab launch buttons. This can be useful if you have installed KPN Mobile Internet Software on a new computer.

To import saved Websites Tab items:
1. Select **Settings, Advanced Settings, Import Profiles**.
2. Enter the name of the file you want to import in the **Select file** field, or else click on the **Browse...** button and search for the file using the displayed Open dialog.
3. Click **OK**.

The file you select must be a correctly-formatted KPN Mobile Internet Software configuration import/export file, as created by the Export Profiles function.
Preferences

The Preferences dialog allows you to set a variety of general application preferences. You can access and configure various settings using the following tabs:

• General Tab
• Connect Tab
• WLAN Tab
• Roaming Tab
• indow Tab
• SMS Tab

General Preferences Tab

You can edit the following using the General Preferences tab:

• Auto start - Check this option if you want KPN Mobile Internet Software to be automatically started after system boot.
• Automatically select devices at start-up - Check this option if you want KPN Mobile Internet Software to automatically select devices on start-up.
• View selection dialog if auto selection fails - Check this option if you want KPN Mobile Internet Software to display a device selection dialog if start-up device selection fails.
• Automatically select default device at Plug and Play - Check this option if you want KPN Mobile Internet Software to automatically select the default device when a new device is inserted and recognized by the Windows Plug ‘n’ Play system.
• View selection dialog if auto selection fails - Check this option if you want KPN Mobile Internet Software to display a device selection dialog if Plug and Play device selection fails.
• Always auto select inserted device - Check this option if you want KPN Mobile Internet Software to always automatically select new devices when they are inserted.
• Auto scan for networks in active profile - Check this option if you want KPN Mobile Internet Software to periodically scan for the networks in the active profile.
• Scan interval in minutes - Specify how often you want KPN Mobile Internet Software to scan for networks.

Connect tab

You can edit the following using the Connect tab:

• Automatically connect on application startup - Check this option if you want KPN Mobile Internet Software to automatically connect using the active profile as soon as it is started.
• User confirmed disconnect - Check this option if you want KPN Mobile Internet Software to request confirmation before disconnecting from a network.
• Connect retry - Select what you want KPN Mobile Internet Software to do when a connection attempt fails:
• Automatically reconnect on lost connection - Check this option if you want KPN Mobile Internet Software to automatically try reconnecting when connections are lost.
• **Connect interval in seconds** - Specify how long you want KPN Mobile Internet Software to wait between reconnection attempts.
• **Max connect tries** - Specify the number of times you want KPN Mobile Internet Software to try to reconnect.
• **Unlimited connect tries** - Check this option if you want KPN Mobile Internet Software to try to reconnect indefinitely.

**WLAN tab**
You can edit the following using the WLAN tab:
• **Auto scan for wireless networks** - Check this option if you want KPN Mobile Internet Software to periodically search for new WLAN networks.
• **Intervals between scans in minutes** - Specify how frequently you want to search for new WLAN networks.
• **Popup dialog when networks are found** - Check this option if you want KPN Mobile Internet Software to display a dialog whenever a new network is discovered.

**Roaming tab**
You can edit the following using the Roaming tab:
• **Use roaming threshold** - Check this option if you want KPN Mobile Internet Software to warn you of your data usage while roaming. This means that you can keep track of your network usage and avoid high costs.

There are two types of roaming thresholds:
• Thresholds set to warn at intervals based on data usage
• Thresholds set to warn at intervals based on estimated cost.

Which of these two methods that will be used is determined by the data supplied by your operator. If your operator has supplied a pricelist, roaming thresholds will be set based on estimated cost. KPN Mobile Internet Software will then take the price for the network you connect to and calculate the estimated cost. A warning will be displayed each time you reach the threshold value you set.

If your operator has not supplied a pricelist, you will only be able to set a threshold based on megabytes. You can set the warnings to occur after 1 megabyte transferred or higher.

**Window tab**
You can edit the following using the Window tab:
• **Always on top** - Check this option if you want KPN Mobile Internet Software window to be displayed on top of all other windows.
• **Window startup size** - Select how you want KPN Mobile Internet Software window to be on start up: expanded or minimized.
**SMS Tab**

You can edit the following using the SMS tab:

- **Show Operator SMS notifications** - Check this option to receive SMS messages from your operator.
- **Notify when new SMS arrives** - Check this option to receive a pop-up notification when a new SMS message is received.
- **Play sound when new SMS arrives** - If you wish to receive notifications for new SMS messages, you can also opt to select a sound for that notification from the list of sound files provided.

**Restore Configuration**

The Restore Configuration dialog allows you to:

- Restore KPN Mobile Internet Software's original configuration or to restore other earlier configurations that you have saved by setting restore points.
- Set restore points in order to save a working configuration that you can easily return to.

This function is very useful if you are experimenting with a variety of set-ups. Before you start changing settings you can create a restore point to which you can easily return if your changes don’t work as expected.

To create a restore point:

1. Select **Settings, Advanced Settings..., Restore Configuration**.
2. Enter a name in the **Restore point** name field.
3. Click on **Create**.

The new restore point is then added to the Restore points list.

To restore an earlier configuration:

1. Select the required restore point from the **Restore points** list.
2. Click on **Restore**.
3. Confirm your selection by clicking **Yes**.

To restore the original delivered configuration:

1. Click on **Restore default**.
2. Confirm your selection by clicking **Yes**.

To delete a restore point:

1. Select the required restore point from the **Restore points** list.
2. Click on **Delete**.
3. Confirm your selection by clicking **Yes**.

**Set Password**

The Set Password dialog is normally used by a system administrator to prevent ordinary users from accessing advanced options in a configuration created for widespread distribution.
To set password protection:
1. Select **Settings, Advanced Settings...**, Set Password.
2. Select **Enable password**.
3. Enter your password twice, in the **Password** and **Confirm password** fields.
4. Click on **OK**.

To remove password protection:
1. Select **Disable password**.
2. Click on **OK**.

**Personal Usage Meter**

The Personal Usage Meter Settings opens the Usage Meter Settings dialog where you can set limits or thresholds for your data usage.

To set usage thresholds, select the checkbox to **Enable data usage thresholds** and enter the amount you wish to set as your limit in the **Usage threshold in MB** field.

[Image]

If you are a Subscription customer, the **Start date** for the tracking period can be edited to reflect the first day of your billing cycle. If you are a Prepaid customer, the Start date for the tracking period cannot be edited.

To select the frequency in which you receive notifications, select the checkboxes for the corresponding increments you wish to be notified. For example, if your limit is set at 100MB and you select 50%, you will receive a warning notification when you are 50% through the 100 MB, or after using 50 MB of data.
Detailed explanation:

You can follow your data-usage with the graphical representation of the “personal usage meter” in the main-screen:

When your total data-usage is 25% of your pre-set data-limit, so 25 MB in this case, you will get a warming-message (pop-up), informing you about this:

When your total data-usage is 50% of your pre-set data-limit, so 50 MB in this case, you will get a warming-message (pop-up), informing you about this:

When your total data-usage is 75% of your pre-set data-limit, so 75 MB in this case, you will get a warming-message (pop-up), informing you about this:
When your total data-usage now passes your pre-set data-limit, so 100 MB in this case, you will get again a warming-message (pop-up), informing you about this:

![Notification](image)

Also, in the screen below, you can see that the total data-usage is now more than 100 MB, and the data-counter is full and has a red warning above it.

![Screen](image)

Click the **Reset Threshold** button to restore the default settings.
The Help Menu

The Help Menu contains the following options:

- **Help**
  Displays Help about KPN Mobile Internet Software

- **Diagnostics**
  Displays the Diagnostics window for use in troubleshooting connection issues.

- **About**
  Displays copyright and version information about KPN Mobile Internet Software.

![Help Menu Image](image)

SMS/Text Messaging

KPN Mobile Internet Software includes an SMS (text messaging) application you can start by clicking on the Envelope icon on the Connection tab. The application allows you to:

- Send, receive, reply to, forward and save messages.
- Import/export contact details from/to the SIM card and also import contact details from Microsoft Outlook or a CSV file.
- Edit contact details.

From the **Contacts** menu you can import or export contacts from/to the SIM card as well as import contacts from the MS Outlook Address book.

The **Actions** menu allows you to perform actions on the messages stored in the application's folders, create personal folders and move messages between folders.
The **Extra** menu allows you to modify the application’s parameter settings. Normally, the SMS application reads all the parameters it needs from the device SIM card. You should therefore not need to change these settings.

If you send a message when there is no device SIM card installed, then it is stored in the SMS application’s **Outbox** folder for sending when a connection becomes available.

**Messaging Functions**

Incoming SMS text-messages are shown in the Windows task-bar on the right-bottom:

![New SMS from: +31611223344 Hello, how are you?](image)

In the **Main-screen** of the program it is also visible as a darker envelope, and if you put your mouse on it, it will show the number of new (unread) incoming messages:
From here you can also read the incoming message:

Hello, how are you... +31611223344  30-8-2010 14:07...
To send a **message**:
1. Click the **New** button.
2. Enter the recipient’s mobile phone number in the **To** field. If there are several recipients, separate the numbers with a semicolon (;). You can also select recipients from your **Contacts** list by clicking **To**.
3. Compose your message in the **Message** field and click **Send**.

To **reply** to a received message:
1. Open the message to which you want to reply and click **Reply**.
2. Compose your message in the **Message** field and click **Send**.

To **forward** a text message:
1. Open the message you want to forward and click **Forward**.
2. Enter the recipient’s mobile phone number in the **To** field. If there are several recipients, separate the numbers with a semicolon (;). You can also select recipients from your **Contacts** list by clicking **To**.
3. Compose your message in the **Message** field and click **Send**.

To **delete** a text message:
Select the message you want to delete and click **Delete**.

To save, edit or delete a text message **draft**:
1. Save a composed text message draft in the **Drafts** folder by clicking **Save**.
2. Edit a saved text message draft by opening it from the **Drafts** folder.
3. Delete a saved text message draft by selecting it and then selecting **Actions, Delete**.
Managing Contacts

You can manage all of your messaging contacts used in KPN Mobile Internet Software SMS.

To add a contact:
1. Click on the SMS icon on the status pane Connection tab.
2. Select the Contacts folder, then click on the New button.
3. Fill in the Name and Phone number fields.
4. Click OK.

To edit a contact:
1. Click on the SMS icon on the status pane Connection tab.
2. Select the Contacts folder, then select the contact.
3. Double-click on the contact or click on the Edit button.
4. Make your changes in the Name and Phone number fields.
5. Click OK.

To delete a contact:
1. Click on the SMS icon on the status pane Connection tab.
2. Select the Contacts folder, then select the contact you wish to delete.
3. Click on the Delete button.
4. Click Yes to confirm the deletion.

Importing and exporting contacts:
When you import contacts from any source, the contacts are merged with any existing contacts in the SMS application: if any duplicate contacts are found, you are asked which one you want to keep. This does not, however, happen when you export contacts; in this case existing contacts are simply overwritten.

To merge existing SIM card contacts with contacts from other sources, therefore, you should do as follows:
1. Import contacts from the SIM card.
2. Import contacts from other sources and deal with any conflicts that arise.
3. Export the merged contact list back to the SIM card.
Glossary of Terms

802.11b/g
The most commonly-used wireless LAN standards.

application launch button
A button in the KPN Mobile Internet Software that both launches a network-dependent application and establishes the network connection it needs. The application is not launched until the network connection has been established.

bearer
A general term for various network technologies used to provide a network connection: HSDPA, HSUPA, UMTS (3G), GPRS (2.5G), EDGE (3G), Dial-up (GSM Data), HSCSD, Wi-Fi, LAN.

Bluetooth
A short-range radio technology supporting communication between digital devices.

connection
This term can be used to mean the set of parameters required to establish an Internet connection. It consists of a bearer type selection plus all the additional parameters required to establish a connection over the selected bearer.

default device
There may be several devices installed on a PC, each supporting one or more bearers. Therefore, a default device is automatically selected for each bearer. This device is then used when a connection is established over that bearer.

device
A general term for the piece of wireless/mobile hardware used to connection your PC to the Internet. It can be a built-in or removeable Wi-Fi adapter, a cellular network PC card (the kind you slot into a bay on your PC), PC express card, USB stick or a cellular device embedded into your PC or a mobile phone connected to your PC via a serial cable, USB cable, infra-red connection or Bluetooth connection.

DHCP
See Dynamic Host Configuration Protocol.

DNS
See Domain Name System.
Domain Name System (DNS)
A distributed Internet directory service. DNS is used mostly to translate between domain names and IP addresses, and to control Internet email delivery.

Dynamic Host Configuration Protocol (DHCP)
A protocol for automating the configuration of computers in an IP network.

EDGE
See Enhanced Data for GSM Evolution.

Enhanced Data for GSM Evolution (EDGE)
A GSM-based wireless service that can deliver data at rates of up to 384 Kbps, enabling the delivery of multimedia etc.

General Packet Radio Service (GPRS)
A cellular network technology offering higher capacity data transfer than ordinary GSM connections. GPRS connections are charged based on the amount of data transferred rather than on call duration and can therefore be permanently connected without incurring costs.

Global System for Mobile Communication (GSM)
The cellular telephone standard most commonly used in Europe and Japan. It is not widely used in the US.

GPRS
See General Packet Radio Service.

GSM
See Global System for Mobile Communication.

High-Speed Circuit-Switched Data (HSCSD)
A circuit-switched data transmission mechanism that provides improved data transfer rates over GSM networks.

High-Speed Downlink Packet Access (HSDPA)
A packet-based protocol used in UMTS networks to speed up transfer rates. It provides much faster download speeds than basic UMTS, thus improving the delivery of multimedia etc. over mobile networks.

HSCSD
See High-Speed Circuit-Switched Data.

HSDPA
See High-Speed Downlink Packet Access.
HSUPA
See High-Speed Uplink Packet Access.

HTTP
See Hyper Text Transfer Protocol.

HTTPS
See Hyper Text Transfer Protocol Secure sockets.

Hyper Text Transfer Protocol (HTTP)
The main protocol governing the interaction between web servers and clients (browsers).

Hyper Text Transfer Protocol Secure sockets (HTTPS)
A protocol for secure transmission of private documents over the Internet.

Integrated application
KPN Mobile Internet Software can be used to launch various network-dependent applications. The supported application types are Internet browser, e-mail client, VPN client and custom applications. These integrated applications can be associated with connections, profiles and application launch buttons (also called task buttons). When a connection with an integrated application is established, the integrated application is automatically started.

Internet Protocol (IP)
The basic protocol governing exchange of data between computers across the Internet.

IP
See Internet Protocol.

IP address
A numerical address with the form nnn.nnn.nnn.nnn, used to uniquely identify a host computer within an IP network.

LAN
See local area network.

local area network (LAN)
A high capacity network covering a small geographical area.

profile
A list of connections ordered by preference. You can define several profiles for use in different contexts (different locations, for example), one of which is marked as the active profile. When you connect to the Internet using KPN Mobile Internet Software, it tries to connect using one of the connections in the active profile, starting with the first in the list.
Service Set Identification (SSID)
An identifier or name that uniquely identifies a WLAN

SSID
See Service Set Identification.

task
A task associates an integrated application and/or a profile with an application launch button in the KPN Mobile Internet Software. When you click on the button, a connection in the associated profile is established and the associated application is launched.

task button
See application launch button.

UMTS
See Universal Mobile Telecommunications System.

Universal Mobile Telecommunications System (UMTS)
A third-generation (3G) mobile or cellular phone technology providing high speed data connections.

virtual private network (VPN)
A private network established within the public Internet, protected from eavesdropping by means of encryption.

VPN
See virtual private network.

VPN client
A component of a virtual private network. A VPN client is a program residing in a computer or other network device that maintains an encrypted tunnel through the Internet from the network device to a VPN gateway. It encrypts all outgoing messages to the gateway and decrypts all incoming messages from the gateway.

VPN gateway
A component of a virtual private network. A VPN gateway is a program or device located on the periphery of a secure network such as an intranet that can provide encrypted “tunnels” into the intranet from VPN clients in remote locations. It encrypts all outgoing messages to VPN clients and decrypts all incoming messages from VPN clients.

VPN tunnel
The connection between a VPN client and a VPN gateway, through which encrypted data is exchanged.
Wi-Fi
See Wireless Fidelity.

Wireless Fidelity (Wi-Fi)
A commonly-used name for 802.11b/g based wireless LAN technology.

wireless LAN (WLAN)
A high capacity wireless network covering a small geographical area.

WLAN
See wireless LAN.
Guarantee: Terms and conditions

Your purchase is guaranteed against faulty materials or workmanship for a period of 24 calendar months from the date of installation or the date of purchase, whatever date is later, if and when used in a proper way. Batteries shall be guaranteed for a period of six months.

Notwithstanding statutory rights, during the period of this guarantee any components of the unit which are proved to be faulty or defective in manufacture will be exchanged or repaired free of material charges and free of labor charges if repaired directly by KPN.

Your purchase has not been properly used in the event it:
• is neglected;
• is used imprudently, recklessly and/or incompetently;
• is in violation of instructions in the user manual or instructions provided by the manufacturers or KPN has been connected, installed, used and/or combined with other products.

If your purchase does not function properly, please contact a KPN shop. You’ll find the nearest KPN shop and the opening hours on www.kpn.com.

KPN will require proof of purchase in order to ascertain when and where you have purchased the specific product.
Frequently Asked Questions

Question 1:
What can I do with a Dongle?

Answer 1:
A Dongle is a USB-Modem with which you can send emails and use the internet whenever you have a Mobile Internet on your Laptop subscription. Put the dongle in a USB-port on your computer. It will fit on any laptop or desktop with a USB-port. Your computer must fulfill the following requirements:

**Microsoft:**
- Windows XP SP3, Windows Vista, Windows 7 or Windows 8 (Desktop)
- USB port
- 1 GB RAM memory
- 100 MB free hard-disk space

**Apple:**
- Mac OS X 10.4 of higher
- USB port
- 1 GB RAM memory
- 100 MB free hard-disk space

Question 2
Why doesn't the installation of the software work?

Answer 2:
Check:
- If you have (enough) administrator rights on your computer.
- If your virus scanner is not blocking the installation. Temporarily disable it, if this is the case.
- If your firewall is not blocking the installation. Temporarily disable it, if this is the case.

If the installation program does not run automatically, look for the drive your computer has assigned to the dongle (i.e. D:; E:; F:) and start the “Setup.exe” on this drive.

Question 3:
The installation of the software was successful, but why can’t the software find a network?
Answer 3:
It can occur occasionally that the installation is not completely finished yet. Try the following:
• Take the dongle out of the USB-port. Replace the dongle in the port after 5 seconds.
• Place the dongle in another USB-port on your computer.
• Turn your computer Off and On again.
• Go to the Control Panel – Hardware - Device Manager, and check here whether there are any hardware problems that are reported by yellow triangles. If this is the case, right-click on these, and choose: “Update Driver Software...”.

Question 4:
The software does start, but it says that the SIM card is not found, followed by ‘No service’.

Answer 4:
Check if the SIM card is inserted in the dongle in the right way.

Question 5:
The software starts correctly. In the screen it says ‘Ready to connect’, but if I press the connect button nothing happens and eventually I get an error message.

Answer 5:
First wait for about 1 minute, and try again to click the “Connect“-button.

Do you have a Prepaid data plan? Check if the option Prepaid is switched on, as follows:
1. Start the Mobile Internet Software and choose the tab ‘Connection’.
2. Choose ‘Options’ from the menu and tick ‘Enable Prepaid’.
3. Check in the ‘Account’ tab if it says: ‘Your account type is Prepaid’.
4. If you have a subscription check that Prepaid is switched off.

Question 6:
How can I see which type of connection is active on my Mobile Internet Software?

Answer 6:
The Mobile Internet Software shows you the type of connection it has: LAN, WiFi, or 2G/3G. The icon that is highlighted shows you which connection is active.
• LAN means you are connected by a cable.
• WiFi (or WLAN) means you have a wireless connection, either with a home, or business network.
• 2G/3G means that you are connected to a mobile network.
A mobile internet connection is set up by clicking the connect button, in the top right-hand corner of the main screen (tab ‘Connection’) of the Mobile Internet Software.

The software automatically chooses the best (quickest/cheapest) connection type (LAN, WiFi, 2G/3G), while you can continue using internet. This means that you use less data (Megabytes) over 2G/3G Mobile Networks and that therefore your bills are lower.

It can occur that a data-download that has already started, continues over 2G/3G, even though the software has already switched to WLAN, for example. This could be a session in which you listen to radio or when you’re downloading a file.

To be sure that all ‘new’ data goes over WLAN, cancel downloads that started on 2G/3G and restart them again.

**Question 7:**
How can I activate or deactivate the PIN-code of my SIM-card?

**Answer 7:**
To (de)activate the PIN-code of your SIM-card:
1. Start the Mobile Internet Software and chose the tab ‘Connection’.
2. Chose the menu ‘Settings’ and then ‘PIN management’.
3. In this menu you can either deactivate or reactivate the PIN-code of your SIM-card.
4. You can also change the PIN-code of your SIM-card in this menu.

The default PIN-code of a new SIM-card is 0000. Do not forget the PIN-code if you choose to change it, because you will not be able to establish a connection without it.
You can only change your PIN-code if you are off-line (not connected).

**Wrong PIN-code**
If you enter the wrong PIN-code, you will receive a warning message which contains the number of tries you have left to enter the correct PIN-code before the SIM-card is blocked. In most cases the SIM-card will be blocked after you have entered the wrong PIN-code three times. When the SIM-card is blocked, you will have to enter the PUK-code to unblock it. Contact the customer service center for information about your PUK-code.

**Question 8:**
I reach the limit of my Mobile Internet bundle very quickly. What can I do?

**Answer 8:**
When you reach the bundle limit of your Mobile Internet subscription very quickly, there are a number of things you can do:
• Make sure that you use a home or corporate network (over WiFi) as much as possible.
• Limit the use of streaming video (e.g. YouTube) or audio, as this uses relatively many MB's.
• Try to do as many updates as you can on your home or corporate network (over WiFi) and/or switch off your automatic updates.
• It can be useful to switch to a subscription with a bigger data bundle.

Question 9:
What does Internet on your Laptop or Tablet cost within the Netherlands?

Answer 9:
You can view the current tariffs of your Mobile Internet Subscription on the website of your provider, or you can contact the customer support center.

Question 10:
What does internet on your Laptop or Tablet cost outside the Netherlands?

Answer 10:
Different tariffs apply for the use of your Mobile Internet Subscription outside, rather than inside The Netherlands.

Warning! Costs made outside The Netherlands are not part of your Mobile Internet Subscription, but will be charged separately.

Tips:
1. Switch off the automatic updates of applications like Windows Update and Virus scanners before going abroad. This might prevent you from high costs.
2. The dashboard of the Mobile Internet Software will show you which network you are using.

Question 11:
How can I select a network with my Mobile Internet Software in and outside The Netherlands?

Answer 11:
When you set-up a data connection in The Netherlands or abroad, the Mobile Internet Software will automatically select a network. When more than one UMTS/GPRS network is available, you can also select a network manually. In some cases this can be useful regarding cost on, or the quality of, the network.

How to select a network:
1. Start the Mobile Internet Software and select the tab 'Connection'.
2. Chose the menu 'Networks' and then 'Network Selection...'.

65
3. Here you can make a choice between automatic or manual network selection.
5. Choose ‘Select network’ to open the window ‘Change Network Operator’.
6. Select your preferred network and click ‘Change Operator’.
7. Click ‘OK’.

Warning! When using internet outside The Netherlands different tariffs apply!

Question 12:
How can I view the data usage I have done with my dongle and set a limit on my usage?

Answer:
The Mobile Internet Software contains a useful tool with which you can keep track of your data usage. You can set your own data bundle limit in the software, and add warnings which will warn you during your usage. The main screen of the software contains a clear usage meter. All settings can be found in the tab ‘Usage’ and then in ‘Usage Meter Settings’.

Note: You have to enter a start date. This date has to correspond to the dates on your bill!

Tick the box ‘Enable data usage threshold’ and enter the amount of MB’s you want as your limit in the box ‘Usage threshold in MB’. When you have a subscription you can change the ‘Bill Period Start Date’ in the first day of the period over which you receive a bill. If you are a prepaid customer you cannot change the ‘Bill Period Start Date’.

Setting Warning Thresholds:
The intervals at which you receive warnings can be set by ticking the corresponding boxes. E.g. If you have set the total number of MB’s in your subscription on 100, and you tick the box 50%, you will receive a warning after 50MB’s, which is 50% of 100MB.

Question 13:
How can a Prepaid customer request his balance with the Mobile Internet Software?

Answer 13:
If you are a Prepaid customer you can use the tab ‘Account’ to request your balance. In the menu click ‘Settings’ and tick ‘Enable Prepaid’ to switch the software to Prepaid (this will only work if you have a Prepaid SIM-card).
When you click the button ‘Check Balance’ in the tab ‘Account’, you will receive a message containing your remaining balance.
Note: You can only use the button ‘Check Balance’ if you inserted your SIM-card correctly, you have entered the PIN-code and you are connected to a Mobile Network (2G/3G) (see the signal strength bars). You can also look up your Prepaid balance online.
It is possible that your modem or configuration does not support this functionality.

**Question 14:**
Can I use the Mobile Internet Software on a Tablet (ie. iPad)?

**Answer 14:**
No, at this moment the software can only be used in combination with a Windows or Apple computer. See question #1.

**Question 15:**
What is my data usage regarding different internet services?

**Answer 15:**
In the overview below indications can be found of the data usage of different internet services. Multiply the amount of times you use a different service by the amount of MB's it uses and you will have the total number of MB's that you use. Multiply the amount of MB's by the amount of Euro's you pay per MB and you will have an indication of the total costs of your data usage.

<table>
<thead>
<tr>
<th>What</th>
<th>Average usage*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending text e-mail without attachment</td>
<td>0,01 MB</td>
</tr>
<tr>
<td>Sending/viewing email or newsletter in HTML lay-out</td>
<td>0,05 MB</td>
</tr>
<tr>
<td>Webpage with a few pictures</td>
<td>0,20 MB</td>
</tr>
<tr>
<td>Webpage with a lot of pictures</td>
<td>0,25 MB</td>
</tr>
<tr>
<td>Opening/sending a Word document</td>
<td>0,50 MB</td>
</tr>
<tr>
<td>Opening/sending a Excel document</td>
<td>1 MB</td>
</tr>
<tr>
<td>Listening to online radio (per minute)</td>
<td>1 MB</td>
</tr>
<tr>
<td>Down/Uploading photographs</td>
<td>2 MB</td>
</tr>
<tr>
<td>Opening/sending a PowerPoint document</td>
<td>3 MB</td>
</tr>
<tr>
<td>Down/Uploading a music file (MP3)</td>
<td>4 MB</td>
</tr>
<tr>
<td>Video-streaming (per minute) in low resolution</td>
<td>8 MB</td>
</tr>
</tbody>
</table>

* These averages are just an indication. No rights can be derived from these numbers.